
1

Oracle® Application Testing Suite
Release Notes

Release 12.5.0.3   

E17387-19

April 2016

This document includes updated information for Oracle Application Testing Suite 
version 12.5.0.3. The information in this document is more up-to-date than that in the 
manuals. Many of the issues outlined in this document will be corrected in upcoming 
releases. If you have any questions or problems, please contact our support group at 
http://www.oracle.com/support/index.html.
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New Features and Updates in this Release
This version includes maintenance improvements to the existing features as well as 
new features outlined below.

Oracle Application Testing Suite 12.5.0.3 - New Features and Updates
■ Oracle Application Testing Suite Administrator LDAP Properties - Oracle 

Application Testing Suite Administrator includes additional LDAP properties for 
specifying group and user attributes in the Setup LDAP Configuration for use 
with Oracle Test Manager. The LDAP configuration user interface replaces the 
ldap.properties file requirements.

■ Oracle Application Testing Suite Installation - Oracle Application Testing Suite 
Installation supports 64 bit JDK for Windows 64 bit platforms.

■ Oracle Application Testing Suite WebLogic Server - Oracle Application Testing 
Suite has been upgraded to use Oracle WebLogic server 12c (12.1.3).
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■ Oracle Test Manager Agent Queue - Oracle Test Manager includes an agent 
queue to handle situations when multiple (2 or more) testers execute OpenScript 
tests using the same Oracle Test Manger agent system. Oracle Test Manager checks 
if the requested agent system is available. If the agent system is not available the 
test is added to the agent queue until the agent system resource is available.

■ Oracle OpenScript Recording and Playback with Chrome Browser - Oracle 
OpenScript supports recording both functional test scripts and load testing scripts 
with the Chrome browser. The supported version of Chrome browser for 
recording/playback is version 33 and higher.

■ Oracle OpenScript Playback with Safari Browser Simulator - Oracle OpenScript 
supports playback of pre-recorded Web/ADF functional test scripts using a Safari 
browser simulator. The testing configuration requires a Apple Macintosh 
computer running OS X and the Apple Xcode iOS simulator software. See the 
Oracle Application Testing Suite Installation Guide for additional information.

■ Oracle Load Testing Report Graphs - Oracle Load Testing includes updated 
reporting using Application Development Framework (ADF)-based graphs.

Announcements
1. End of Support for Internet Explorer 10.x is Being Planned for Future Releases of 

Oracle Application Testing Suite.

End of Support for Internet Explorer 10.x
Upcoming end of support in Oracle Application Testing Suite - Internet Explorer 
version 10.x.

What is being announced?
Oracle Application Testing Suite version 12.5.0.3 is planned to be the last version to 
support Internet Explorer 10.x. IE 9.x will only be supported on Win2008 SP2.

Why is this being announced?
Microsoft has announced an updated support policy for Internet Explorer browsers. 

What is the impact of end of support?
The end of support will mean customers will have to move their test platform to a 
supported browser.

What do you need to do?
What will you do as Internet Explorer 10.x support is removed in a future release?

If Internet Explorer 10.x browser is being used in your environment, you should begin 
planning for the end of support for Internet Explorer 10.x and system upgrades to 
make sure the continuity of your test process management, while Internet Explorer 
10.x support is phased out in a future release. 

Who to contact for more information?
If you have any questions or concerns regarding this upcoming change, please update 
the My Oracle Support Communities thread to get resolutions, information or access 
to the Oracle Application Testing Suite Product Management. 
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The related My Oracle Support Communities thread can be accessed here: 
https://communities.oracle.com/portal/server.pt/community/view_discussion_
topic/216?threadid=280470&doPagination=false&Portlet=View%20Discussion&Pre
vPage=Communities-EditDiscussion.

The related Microsoft lifecycle factsheet can be accessed here: 
https://support.microsoft.com/en-us/lifecycle#gp/Microsoft-Internet-Explor
er.

System Requirements
Oracle Application Testing Suite has the following system requirements:

Oracle Functional Testing/OpenScript
Oracle Functional Testing’s OpenScript scripting platform has the following system 
requirements:

■ Operating System (32-bit and 64-bit versions): Windows 7, Windows 8.1, Windows 
2008, Windows 2008 R2, Windows 2012 Server.

■ Memory: Minimum 1 GB

■ System: x86, 32-bit or 64-bit processor, 2.6 GHz or faster

■ Disk Space: 4 GB minimum

■ Browser: Internet Explorer 9.x, 10.x, 11.x; Firefox (ESR) 10.x, 17.x, 24.x, 31.x, 38.x, 
45.x; Chrome 33 or higher.

■ Oracle Forms: Oracle E-Business Suite Release 12 (Forms 10g) running on Sun JRE 
and E-Business Suite Release 11i (Forms 6i). Note that E-Business Suite versions 
running on Jinitiator are not supported with the Oracle EBS/Forms Functional 
Test module. If your E-Business Suite version runs using Jinitiator, you should use 
Oracle Application Testing Suite version 12.3.0.x (or previous versions).

■ Java Runtime Environment: JRE 1.6 minimum, JRE 1.7, JRE 1.8.

Oracle Load Testing
Oracle Load Testing has the following system requirements:

■ Operating System (32-bit and 64-bit versions): Windows 7, Windows 8.1, Windows 
2008, Windows 2008 R2, Windows 2012 Server. Oracle Enterprise Linux 5.x, 6.x 
(64-bit versions only). Windows 2008 R2 and Windows 2012 Server are supported 
systems for functional test-type scripts during load tests.

■ Memory: Minimum 2 GB.

■ System: x86, 32-bit or 64-bit processor, 2.6 GHz or faster

■ Disk Space: 10 GB minimum free (at least 3 GB free on the system drive)

■ Browser: Internet Explorer 10.x, 11.x; Firefox (ESR) 10.x, 17.x., 24.x, 31.x, 38.x.

■ Database: Oracle EE 11g EE 12c, XE 11g.

■ Application Server: Oracle WebLogic 12c (12.1.3.0). Oracle Application Testing 
Suite requires the standard WebLogic Server installation. It does not support 
generic versions of WebLogic Server installation (such as those that use wls1035_
generic.jar). 
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After installing Oracle Application Testing Suite release 12.4.0.2 and above, 
manually download and apply Oracle WebLogic Server security patches for 
Oracle WebLogic release 12.1.3.0, as specified in the My Oracle Support Doc ID 
2075927.1:

https://support.oracle.com/rs?type=doc&id=2075927.1

■ Oracle Load Testing Agent also supported on Linux 64-bit, in addition to 
Windows 32-bit and 64-bit operating systems listed above.

Oracle Test Manager
Oracle Test Manager has the following system requirements:

■ Operating System (32-bit and 64-bit versions): Windows 7, Windows 8.1, Windows 
2008, Windows 2008 R2, Windows 2012 Server. Oracle Enterprise Linux 5.x, 6.x 
(64-bit versions only).

■ Memory: Minimum 2 GB.

■ System: x86, 32-bit or 64-bit processor, 2.6 GHz or faster

■ Disk Space: 10 GB minimum free (at least 3 GB free on the system drive)

■ Browser: Internet Explorer 9.x, 10.x, 11.x; Firefox 10.x, 17.x., 24.x, 31.x, 38.x.

■ Database: Oracle EE 11g EE 12c, XE 11g. 

■ Application Server: Oracle WebLogic 12c (12.1.3.0). Oracle Application Testing 
Suite requires the standard WebLogic Server installation. It does not support 
generic versions of WebLogic Server installation (such as those that use wls1035_
generic.jar). 

After installing Oracle Application Testing Suite release 12.4.0.2 and above, 
manually download and apply Oracle WebLogic Server security patches for 
Oracle WebLogic release 12.1.3.0, as specified in the My Oracle Support Doc ID 
2075927.1:

https://support.oracle.com/rs?type=doc&id=2075927.1

Note: These are minimum requirements only and actual 
requirements for the Oracle Load Testing Server will vary depending 
on the size and configuration of your load test. If you are running 
larger load tests, of greater than 1000 Virtual Users, you should 
consider deploying Oracle Load Testing on a faster server class 
machine with additional RAM recommended.

Note: Oracle recommends running the Oracle Load Testing Server 
and Agents on separate systems for production load testing. The 
amount of memory required on the Oracle Load Testing Agent 
systems may increase based on the number of Virtual Users that will 
be assigned to run on each Agent. For more information, visit the 
QA/Testing Technology Center on Oracle Technology Network or 
contact your Oracle representative.
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Additional Notes
The following are additional notes about system requirements:

■ The Oracle Application Testing Suite/OpenScript PeopleSoft Load Testing 
Accelerator does not support the Websockets/Push Notification Framework 
features provided in Oracle's PeopleSoft PeopleTools 8.54+. 

■ The Oracle Application Testing Suite is compatible with an Oracle 11g Express 
Edition (XE) database for use with Oracle Load Testing and Oracle Test Manager. 
Although this is useful for demos, for production usage switching to Oracle's 11g 
Enterprise Edition or Oracle's 12c Enterprise Edition database is highly 
recommended. Oracle 11g Standard Edition and Oracle 11g EE or SE are also 
supported.

■ The Oracle Express Edition (XE) database or Oracle Enterprise Edition database 
must be downloaded and installed separately before the ATS download and 
install. 

■ System memory requirements do not take into account other processes that may 
be running and using memory on your system, reducing free uncommitted 
memory available.

■ When installed on the same machine, Oracle Load Testing and Oracle Test 
Manager will run on the same server and use shared system resources. Oracle 
Functional Test/OpenScript is a separate application that has its own memory and 
CPU requirements.

■ Oracle Load Testing allows you to distribute your Virtual Users to run from 
remote Agent machines. Users must install the Agent-Only Remote Agent install 
component on their Agent machines to enable this functionality.

■ When recording and playing back EBS/Forms functional test scripts, all JRE 
Plug-in security dialogs are automatically suppressed. Unsigned, self-signed and 
other security vulnerable applications can be automatically allowed to run.

■ Oracle Application Testing Suite cannot be installed on a 64-bit WebLogic on MS 
Windows. The Oracle Application Testing Suite products will run in 32-bit 
compatibility mode when installed on 64-bit MS Windows operating systems. It is 
possible for Oracle Application Testing Suite to be installed on an existing 
WebLogic server. However, if the pre-installed WebLogic server is JRockit plus 
WebLogic (64-bit) environment, some functions in Oracle Application Testing 
Suite will not work properly.

■ The legacy Oracle Functional Testing, VB-based scripting platform and associated 
components (such as Job Scheduler) are no longer included with the ATS installer 
starting with version 9.2. Customers that still require this product should use ATS 
9.1 or older versions supported under Oracle’s Lifetime Support Policy. 

Note: These are minimum requirements only and actual 
requirements for Oracle Test Manager will vary depending on the 
quantity of test assets stored and number of concurrent users 
accessing the application. If you have a large quantity of test cases, 
requirements or issues stored and/or are deploying Oracle Test 
Manager for a team greater than 10 users, you should consider 
deploying Oracle Test Manager on a faster server class machine with 
additional RAM recommended.
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Installing the Oracle Application Testing Suite
See the Oracle Application Testing Suite Installation Guide.

Tutorial and Documentation for the Oracle Application Testing 
Suite
The Oracle Application Testing Suite includes product documentation in Adobe 
Acrobat .PDF format and online help for each application and utility. The 
documentation includes electronic versions of the Getting Started Guide, OpenScript 
User's Guide, Oracle Load Testing User's Guide, Oracle Test Manager User's Guide 
and Release Notes. The PDF files are installed to the <installDir>/docs directory.

You need the Adobe® Acrobat® Reader v4 (or newer) to open and view the 
documents. You can download the reader from the Adobe web site at 
http://get.adobe.com/reader/.

All of the components of the Oracle Application Testing Suite include comprehensive 
online Help. You can access the online help using the Help menu options inside of 
each product.

Known Problems, Limitations and Workarounds
This section lists known issues and workaround solutions for the components in the 
Oracle Application Testing Suite.

Oracle Application Testing Suite
The following are known issues and workaround solutions for Oracle Application 
Testing Suite.

■ When upgrading Oracle Application Testing Suite from a previous version, the 
installation process may display a Confirm message indicating the Oracle Test 
Manager schema is an older version and must be upgraded to the latest version. 
The message recommends making a backup of the schema and requires you to 
select the I have a backup of the schema I am about to upgrade checkbox before 
proceeding. 

If you do not have a backup of the schema click No to exit the installation and 
make a backup of the schema before proceeding. See the "Exporting and Importing 
Databases" section of the Configuring Databases chapter of the Oracle Test Manager 
User’s Guide or online help for information about backing up the database.

Note: On Windows 7  (UAC systems), it is necessary to run 
commands from an elevated command line in order to restart services. 
If you try to run it from the Start menu, you will see the following 
errors in the cmd window: 

System error 5 has occurred.
Access is denied.

Run services.msc from the command line and restart the services 
from there. Windows 7 (UAC systems) require administrator 
privileges to run commands from an elevated command line in order 
to stop and restart services. 
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If you do have a backup of the schema, select the I have a backup of the schema I 
am about to upgrade checkbox and click Yes to proceed with the installation. If 
the upgrade procedure detects any problems with the database (such as duplicate 
records or incorrect sequence values) it will automatically correct the problems. 

■ Problem: Oracle Load Testing, Oracle Test Manager, and agent server applications  
run out of heap even when set to 1GB on Windows 32-bit installations of Oracle 
Application Testing Suite. 

Resolution: Install and use the 64-bit Oracle Appliction Testing Suite server 
(Oracle Load Testing and Oracle Test Manager) and agent components on Linux to 
set the max heap size to more than 1GB.

■ Problem: FileNotFoundException when upgrading Oracle Application Testing 
Suite from 12.3.0.1 to 12.4.0.1 in linux after running /scratch/.../oats_
home/root.sh: 

java.io.FileNotFoundException:
/scratch/.../oracleats/config/agent_manager_auth.properties (Permission denied)

Resolution: Delete the agent_manager_auth.properties file and run root.sh 
again.

■ Problem: Internet Explorer 8 browser incompatibilities related to Cumulative 
Security Update for Internet Explorer 974455 (patch version 8.0.7600.16385). 

Resolution: Apply the browser updates specified in the Microsoft support article: 
http://support.microsoft.com/en-us/kb/976749.

■ Problem: Non-administrator user experiences problems using Internet Explorer 9 
in Oracle Load Testing or Oracle Test Manager.

Resolution: Non-administrator users should disable protected mode if using 
Internet Explorer 9. 

1. Close Oracle Application Testing Suite applications.

2. Select Internet Options from the Tools menu in IE9.

3. Select the Security tab.

4. Select Local Intranet.

5. Select the Enable Protected Mode checkbox.

6. Click OK.

7. Restart IE9/Oracle Application Testing Suite applications.

■ Problem: If the Oracle Application Testing Suite Application Service does not start 
and the log file <installdir>\oats\servers\AdminServer\logs\AdminServer.log 
contains the following error: 

weblogic.store.PersistentStoreException: [Store:280073]The file store "WLS_
DIAGNOSTICS" could not be opened because it contained a file with the invalid 
version 1. A file of version 2 was expected. 

Resolution: Delete the .DAT file in: 
<installdir>\oats\servers\AdminServer\data\store\diagnostics\ and then restart 
the server.

The behavior may occur when starting Oracle Application Testing Suite 
Application Service and the service stays in starting mode even after the restarting 
service command window disappears. This condition may happen when the 
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Weblogic (WLS) service is stopped abruptly - either from a machine reboot or the 
process is stopped for some reason.

■ Problem:   In some cases, the Oracle Universal Installer (OUI) hangs after 
installing the Oracle Application Testing Suite. If this situation occurs, you can 
verify the installation by checking the installation log (typically C:\Program 
Files\Oracle\inventory\logs\installActions-xxxx.log) for a "OATS installed 
successfully." entry. 

Resolution: Use the Windows Task Manager, Processes tab to end all running 
cmd.exe processes and, if necessary, end the OUI application process in Task 
Manager. 

■ Problem: After you install, you can’t login to Oracle Load Testing, Oracle Test 
Manager, Oracle Administrator, etc.

Resolution: During install, you will be prompted for a default password to use in 
the various OATS products where passwords may be required. It’s important that 
you remember or write down this password as it will be needed to login to these 
applications (username will typically be "default" or "administrator"). If you don’t 
remember the password, you will have to re-run the installer and establish a new 
default password. The passwords can be changed and new user accounts added 
through the Administrator after install.

■ Problem: Installation on Japanese systems with existing Oracle database.

Resolution: In cases where installing Oracle Application Testing Suite on a 
Japanese system with the option to use an existing Oracle database, you will need 
to add a system environment variable NLS_LANG with value of Japanese_
Japan.JA16SJIS and restart the system to apply. If the variable already exists with 
different value on the system, it's not recommended to install ATS on the system 
because the change will affect other applications which use Oracle database.

Oracle Load Testing
The following are known issues and workaround solutions for Oracle Load Testing.

■ Problem: Data Transmission Interruption when loading many graphs or when 
trying to create graphs from very large data sets using Internet Explorer.

Resolution: Reduce the Data Granularity in the Advanced tab of the graph 
options. Set the Max. Data Points to a lower value. For example, from 100 to 50.

■ Problem: Siebel Functional Test script playback halts on Auto Fix dialog box 
waiting for user interaction causing script failure.

Resolution: Verify the correct version of Java is installed. Workaround is to disable 
the "Auto fix" dialog box from appearing in the Seibel application, as follows: 

1. Log into the Siebel application.

2. Site Map (globe icon in the upper right corner).

3. Select Administration then Server Configuration.

4. Select Component Definitions.

5. Select Query (for the top grid).

6. Search for SCCObjMgr* in the Alias field (assuming the Siebel application is 
CallCenter).

7. Select Query in the bottom grid.
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8. Search for the EnableClientHealthCheck parameter.

9. Set value to FALSE.

10. Restart the Siebel service.

■ Problem: Database ServerStats not working on non-US systems.

Resolution: In <installdir>\DataCollector\properties, save a backup of the 
jagent_service.properties file.

Open the jagent_service.properties file and find the line:

JHP.commandline = -Xmx1024M -Dsun.java2d.noddraw=true -cp "${JHP.classpath}" 
-Dsun.net.inetaddr.ttl="0" oracle.oats.dc.fw.jhp.JHPmain ${JHP.server} -logsize 
2000000 -logparts 2 "${JHP.installDir}\\DataCollector\\properties 
agents.properties"

and change it to: 

JHP.commandline = -Xmx1024M -Duser.language=en -Duser.country=US 
-Dsun.java2d.noddraw=true -cp "${JHP.classpath}" -Dsun.net.inetaddr.ttl="0"
oracle.oats.dc.fw.jhp.JHPmain ${JHP.server} -logsize 2000000 -logparts 2 
"${JHP.installDir}\\DataCollector\\properties agents.properties" 

Save the file and restart the agent starter service.

■ Problem: Microsoft Excel Graphs may not be generated on Windows 2008 R2 
machines. If a user tries to export a graph in Oracle Load Testing to and XLS file, it 
may not generate if the system is a Windows 2008 R2 machine, even with MS 
Office 2007 installed. The error in the wls_oats.log file is:

error:  org.jawin.COMException 800a03ec: null 

Resolution: Workaround is to create a folder named "Desktop" (without quotes) in 
the following two locations: 

C:\Windows\System32\config\systemprofile
C:\Windows\SysWOW64\config\systemprofile

■ Problem: Data Collector being forced to authenticate as Guest, no matter what 
credentials are used causing the error Logon failure: unknown user name or bad 
password.

Resolution: Change the machine's local security policy to "Classic" to be able to 
discover Perfmon counters using the local account (Administrator). See the 
following for additional information:

http://msdn.microsoft.com/en-us/library/ek2256kk.aspx

■ Problem: If a Data Collector process (olt-dc-java-agent.exe) was running and you 
restart the Oracle Load Testing server and attempt to do something with 
ServerStats on the server (start a metric, for instance), it will start a second Data 
Collector process that will not function properly because of the lock established by 
the first process.

Resolution: To address this, end the Data Collector process(es) manually, delete 
the lock file(s) ($installDir\DataCollector\bin\*.pid), then repeat the 
ServerStats task attempted previously.

■ Problem: If your script fails to playback successfully in Oracle Load Testing due to 
Windows authentication or other user permissions related issues with your 
application, this may be due to the login authentication of the Oracle Load Testing 
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Agent Service. The Oracle Load Testing Agent Service which runs all the Virtual 
Users on a given Agent system will by default be installed to run under the Local 
System account. This may cause issues for certain applications if they block access 
to this account. 

Resolution: To address this, open the Oracle Load Testing Agent Service in the 
Services panel and change the login to run under a specific user with appropriate 
application permissions.

■ When using the SNMP data source, new SNMP MIBs that users specify are 
uploaded to the Oracle Load Testing Server by default and can be accessed only 
through the Local Oracle Load Testing Data Collector running on that Server. 
Remote Oracle Load Testing Data Collectors cannot access these MIBs and users 
need to copy those over manually.

■ Problem: To use the JMX Data Source, you may need to manually copy the 
server-specific class files to the <installdir>\DataCollector\classes directory on the 
Data Collector machine. These class files are required for each J2EE Application 
supported server. The jar files should be same version as the J2EE Application 
Server. You should get the class files from your Application Server installation. 
The list of required jar files is contained in the Oracle Load Testing 
"agents.properties" file located in <installdir>\DataCollector\properties.

Resolution: To do JMX Discovery on WebLogic 10.3.3, doing the following:

1. Copy <installdir>\lib\wlfullclient.jar to 
<installdir>\DataCollector\classes\weblogic

2. Log in to Oracle Load Testing.

3. Select Metrics from the ServerStats menu then select New.

4. Select the JMX Data Source then click Discover Counters.

5. Select the local system and click Edit.

6. Select Oracle WebLogic 9.1 as the server (port 8088), username oats and the 
password (the password specified when installing the Oracle Application 
Testing Suite product).

7. Click OK.

8. Click OK and the discovery process begins. After a few moments, you will see 
a full list of the MBeans on the server.

The ServerStats JMX discovery caches counter information. The side effect is that it 
also caches error messages. For example, failure to copy the correct jar files to data 
collector's classes directory prior to attempting the discovery would result in an 
error. When the discovery is attempted after copying the jar files, the discovery 
still may not work because of the cache. The recommended workaround is to 
re-start the Oracle Load Testing Server and retry the discovery.

■ Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get 
the following error reported by the browser: "Unable to connect" or "Can't 
establish a connection to the server at localhost:8088."

Resolution: This error indicates that the OATS Application Service is not running.   
Start (or restart) the OATS Application Service on the server machine where you 
installed OATS server. You will also want to make sure that the Oracle Database 
services are also running (this would be OracleServiceXE and 
OracleXETNSListener if you used the Oracle XE database).
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■ Problem: When bringing up OLT (or OTM) you get the following error reported 
by the browser: "Error 404--Not Found"

Resolution: This error indicates that the OATS Application Service is unable to 
connect to the Oracle Database. You will also want to make sure that the Oracle 
Database services are also running and start/restart them if necessary (this would 
be OracleServiceXE and OracleXETNSListener if you used the Oracle XE 
database). Then restart the OATS Application Service.

■ The remote ServerStats Data Collector requires the Agent-Only installation for the 
Remote Agent installed on the remote Data Collector machine. 

Oracle Test Manager
The following are known issues and workaround solutions for Oracle Test Manager.

■ Adding/editing test steps to a test case will not sync the changes with 
uncompleted Test Set Runs created before upgrading to 12.5.0.1. The Test Set Runs 
created after upgrading to 12.5.0.1, which are not completed, will reflect new 
changes made to test steps.

■ Remote execution of JUnit tests or execution of JUnit tests is not supported on 
Linux. Support for this is planned for a future release.

■ The icons in the Tree View for Test Plans, Requirements, Tests, and Issues are 
automatically assigned and cannot currently be configured by the Administrator.

■ After configuring a new database in the Oracle Test Manager Database 
Configuration dialog, users must restart the Oracle Application Testing Suite 
Application Service in order for that database to appear in the Database dropdown 
list on the Oracle Test Manager login page.

■ Problem: A warning message appears indicating there are duplicate custom field 
names when logging into the Administrator (http://hostname:8088/admin) to 
upgrade the OTM database. 

Resolution: The field name(s) listed in the warning message must be renamed 
before the upgrade can be completed. The field name(s) listed in the warning 
message will be different depending on each user's situation. Perform the 
following steps to rename the fields listed in the warning message:

1. Make a note the duplicate field names in the message and click OK to dismiss 
the warning message.

2. Connect to the OTM schema and execute the following SQL statement to find 
the customfieldid. In the example below, the query looks for the 
customfieldid for 'Cycle'. You will need to replace 'Cycle' with the actual field 
name that your upgrade is warning about. The query should return multiple 
results. Note the customfieldid for one of the results because it will be used 
in step 3.

SQL> select customfieldid from "Custom_Field" where name = 'Cycle';

3. The update statement below will change the custom field name for the 
referenced customfieldid. 

– Replace the name with another name that makes sense but is not a 
duplicate (i.e. 'Cycle1').

– Replace the customfieldid with the value obtained from step 2.
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SQL> update "Custom_Field" set name='Cycle1' where customfieldid=32;
1 row updated. 

4. Commit the change to save it.

SQL> commit;
Commit complete. 

5. Go to http://hostname:8088/admin and log into the OTM database again to 
upgrade it.

■ Problem: Error in Tests tab after upgrading from 12.2x to 12.3x.

Resolution: Enable the RunName field in the Administrator, as follows:

1. Close the Oracle Test Manager application.

2. Start the Administrator.

3. Select the Fields tab.

4. Select Test Runs in the left pane.

5. Select the ’RunName’ field.

6. Click Edit.

7. Select Enabled and click OK. 

8. Close the Administrator and restart Oracle Test Manager.

■ Problem: Unable to delete Test Results for a Test executed in a Test Set after the 
Test Set has been deleted from the Test Execution tab (the Test Run appears in the 
Run History section of the Test on the Tests tab but the Run does not appear in the 
Delete Results list).

Resolution: Delete the Test Results from the Run History section of the Test Set on 
the Test Execution tab before deleting the Test Set. If you delete the Test Set before 
deleting the Test Results from the Run History section of the Test Execution tab, 
the Test Results will still appear in the Run History section of the Tests tab. 
However, the Test Result from the Test Set run cannot be deleted from the Run 
History on the Tests tab.

■ Problem: Any chart report with the "Version" field as first field will not show any 
data in the data-view. 

Resolution: Do not use the "Version" field as first field.

■ Problem: Unable to move tree nodes up beyond Previous indicator or down 
beyond Next indicator in the tree view. Move operation results in a "Move 
Operation Failed. Please ensure the node selection is valid." warning message. 

Resolution: Increase the number of displayed nodes in the user options. Select 
Options from the Tools menu, select Tree Preferences and increase the Maximum 
Number of Displayed Nodes value.

■ Problem: Goto does not work for Tree grouped by "Run By" or "Las Run Status". 
This issue may occur after upgrade from Oracle Application Testing Suite pre-9.3x.

Resolution: Perform the following updates against the Oracle Test Manager 
database:

1. Stop ATS service.

2. Open a command prompt.
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3. Type sqlplus <schemaname>/<password><@service>.

4. When connected to the schema, paste following queries:

UPDATE "Special_Field" SET SpecialFieldId=23, label = 'Last Run By' WHERE 
AttachedToTypes=8 and Name='runbyuser'; 

UPDATE "Special_Field" SET SpecialFieldId=24 WHERE AttachedToTypes=8 and 
Name='duration'; 

UPDATE "Special_Field" SET SpecialFieldId=25, Type=7 WHERE 
AttachedToTypes=8 and Name='rundate';

commit;

5. Type quit to exit from sqlplus.

6. Type exit to close the command window.

7. Start the ATS service.

■ Problem: When upgrading from version 9.31 to 12.1, certain pre-existing OTM 
Filters and Groups may no longer work properly. This issue may be associated 
with filters based on usernames, such as "Created By", "Owner", "Last Modified 
By", and with filters based on date and version fields, such as "Last Modified Date" 
field, and "Version" field. 

Resolution: The filters/groups may need to be recreated manually.

■ Problem: Exceptions occur or application hangs when attempting to export 
extremely large projects (projects exceeding 11,000 test cases).

Resolution: For large databases, change Stuck Thread Max Time parameter 
(default value is 600, i.e. 10 min.) for the server using the following steps:

1. Close all OATS applications.

2. Open a browser and go to http://localhost:8088/console/ (or 
http://<server>:8088/console/).

3. Log into WebLogic Server (username "oats", password defined during OATS 
installation).

4. Expand the Environment tree under Domain Structure (left pane).

5. Select Servers.

6. Click the AdminServer(admin) link under Servers (right pane).

7. Click the Tuning tab.

8. Change the value for parameter "Stuck Thread Max Time" to a larger 
appropriate value. 

9.  Click Save then restart the application server.

■ Problem: Oracle Test Manager fails to playback certain OpenScript scripts 
completely.

Resolution: The following additional steps are required in order to run the 
following types of OpenScript scripts from Oracle Test Manager:

■ Siebel Functional

■ Oracle Forms Functional
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■ Web Functional scripts that rely on system input events, such as key press or 
mouse click

■ Web Functional scripts that display modal dialog windows

It is necessary to run these scripts using an interactive desktop of a named 
Windows user account that is always logged in. See also "Command-Line Script 
Execution" for additional information.

1. For Siebel and Oracle Forms, the named user's account must have visited the 
Siebel or Oracle Forms site at least once to ensure that all necessary ActiveX 
controls and plug-ins are installed in the named user's browser.

2. On the Oracle Test Manager agent machine that will run the scripts, stop the 
"Oracle Application Testing Suite Agent Service" and configure it to start 
manually.

3. On the Oracle Test Manager agent machine, login as the named Windows user 
account that will run the scripts. From a command prompt, run the following:

Windows:

$installDir\agentmanager\bin\agentmanager.cmd

Linux:

$installDir\agentmanager\bin\agentmanager.sh

This command starts a Java executable running the agentmanager, it will not 
"run" the service. All output  is logged to the agentmanager.log and the logs of 
individual agents.

4. The named user account must remain logged into the system at all times that 
scripts will be run.

■ Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get 
the following error reported by the browser: "Unable to connect" or "Can't 
establish a connection to the server at localhost:8088."

Resolution: This error indicates that the OATS Application Service is not running. 
Start (or restart) the OATS Application Service on the server machine where you 
installed OATS server. 

You will also want to make sure that the Oracle Database services are also running 
(this would be OracleServiceXE and OracleXETNSListener if you used the Oracle 
XE database).

■ Problem: When bringing up Oracle Load Testing (or Oracle Test Manager) you get 
the following error reported by the browser: "Error 404--Not Found"

Resolution: This error indicates that the OATS Application Service is unable to 
connect to the Oracle Database. You will also want to make sure that the Oracle 
Database services are also running and start/restart them if necessary (this would 
be OracleServiceXE and OracleXETNSListener if you used the Oracle XE 

Note: For Windows 7 systems, the command must be run using the 
elevated command line. From the Start menu, expand the Accessories, 
right click on the Command Prompt menu option and select Run as 
administrator from the shortcut menu. 
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database). Then restart the OATS Application Service. See the above note about 
stopping and restarting services on Windows 7 systems.

Oracle Database 11g Express Edition
The following are known issues and workaround solutions for Oracle Database 11g 
Express Edition.

■ Problem: In some cases, the Oracle Database 11g Express Edition service does not 
start completely. 

Resolution: If you receive a 404 Not Found error when starting Oracle Load 
Testing or Oracle Test Manager, restart the Oracle database service and the Oracle 
Application testing service, as follows:

1. Open the Control panel and the Administrative Tools.

2. Open Services.

3. Select the Oracle Application Testing Suite Application Service and click Stop 
the service.

4. Select the OracleServiceXE service and click Restart the service.

5. Wait for the OracleServiceXE service Status to indicate "Started".

6. Select the Oracle Application Testing Suite Application Service and click Start 
the service.

7. Wait for the Oracle Application Testing Suite Application Service Status to 
indicate "Started".

8. Restart Oracle Load Testing or Oracle Test Manager.

Oracle Functional Testing - OpenScript
The following are known issues and workaround solutions for Oracle OpenScript.

■ Problem: When EBS/Forms automation is enabled, EBS/Forms applications hang 
when launched either for manual access or record/playback of the EBS/Forms 
application.

Resolution: Open the Java Control Panel - Security tab and check the Exception 
Site List. If the EBS/Forms application URL is displayed in the Exception Site List, 
remove the URL from the Exception Site List.

■ Problem: Scripts recorded using IE9 do not playback correctly using IE11. 

Note: On Windows 7 (UAC systems), it is necessary to run 
commands from an elevated command line in order to restart services. 
If you try to run it from the Start menu, you will see the following 
errors in the cmd window: 

System error 5 has occurred.
Access is denied.

Run services.msc from the command line and restart the services 
from there. Windows 7 (UAC systems) require administrator 
privileges to run commands from an elevated command line in order 
to stop and restart services. 
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Resolution: Certain browser versions may record event triggers differently. For 
example, scripts recorded with IE9 record WaitForPage, but scripts recorded on 
IE11 do not record WaitForPage for the same event trigger in some cases. The 
IE9-recorded scripts may not play back correctly using IE11. In this case, use a 
delay time to replace the recorded WaitForPage using the following command 
format:.

getSettings().set("web.REPLACE_WAITFORPAGE_WITH_DELAY", "5600");

or the following command line argument:

-web.REPLACE_WAITFORPAGE_WITH_DELAY 5600

to replace all WaitForPage steps with the specified delay in milliseconds. 

■ Problem: iOS Mobile Safari browser crashes when opening/closing a new tab.

Resolution: Only actions on the currently active window are supported (for 
example get child DOM, run JavaScript). Actions are not supported in windows 
that are not the currently active window.

The following use case is supported:

- Performing actions in one window (the currently active window). For 
example, the currently active window is window index 0, click a link in 
windows index 0, a new window (windows index 1) opens and the currently 
active window is now window index 1. Actions are supported at this moment 
on window index 1. After closing window index 1, the active window is 
window index 0 again. Actions are supported at this moment on window 
index 0. 

The following use case is not currently supported:

- Performing actions on a window that is not the currently active window. For 
example, the currently active window is window index 0, click a link in 
windows index 0 that opens a new window (window index 1) and window 
index 1 becomes the currently active window. Performing actions on the 
original window index 0 at this moment is not supported as window 0 is no 
longer the active window.

■ Problem: OpenScript playback error occurs if the script contains UTF-8 characters. 
The failure may occur as a Replay Action failed and UTF-8 characters are 
converted to question mark (?) characters.

Resolution: Set the OpenScript -Dfile.encoding=UTF8 startup property as 
follows:

1. Close OpenScript.

2. Right-click the OpenScript startup icon/menu option on the Start menu (or 
Desktop icon, if available).

3. Select Properties.

4. Add the -Dfile.encoding=UTF8 property setting to the end of the Target 
string on the Shortcut tab. The full Target string should be as follows:

C:\OracleATS\openScript\OpenScript.exe -configuration openscript_
configuration -vm C:\OracleATS\openScript\jre\bin\javaw.exe -vmargs 
-Xmx512m -XX:MaxPermSize=256m -Dfile.encoding=UTF8

5. Click OK to close the OpenScript Properties.
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6. Restart OpenScript using the modified OpenScript Start icon/menu option (or 
Desktop icon) and playback the script.

■ Problem: OpenScript captures HTTP requests that are for Google use when using 
Google Chrome to record HTTP module scripts. Some examples are as follows:

www.google.com/searchdomaincheck
ssl.gstatic.com
safebrowsing-cache.google.com
safebrowsing.google.com
productforums.google.com
www.googletagmanager.com
www.youtube.com
fonts.gstatic.com
clients4.google.com
www.youtube-nocookie.com

Resolution: Define URL filters for unnecessary URL requests, a follows:

1. Start OpenScript and open an HTTP module script.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript peferences and select HTTP under the Record 
preferences.

4. Open the URL Filters tab.

5. Click Add.

6. Specify a name and URL pattern for each URL you do not want OpenScript to 
capture. Specify Match as URL and Method as Wild card.

7. Click OK to save the filter.

8. Repeat Steps 5 through 7 for each URL.

9. Click OK to save the preferences.

■ Problem: OpenScript recording or playback with Chrome browser not working 
correctly.

Resolution: Verify you have a supported version of the Chrome browser for 
recording and playback. The supported version of Chrome browser for 
recording/playback is version 33 and higher.

■ Problem: OpenScript cannot record TLS 1.2 enabled site when selecting Use TLS 
1.2 in Internet Explorer. 

Resolution: Enable Use SSL 3.0 in Internet Explorer's Advanced Options 
(Security) to perform the recording. This is required even if the site does not accept 
SSL v3 traffic.

■ Problem: OpenScript cannot check Float type values retrieved from a database 
table using == to check whether or not two values are equal. 

Resolution: Use a SQL statement such as "select to_char(columnname) as 
columnname from table" and check the values in OpenScript as String type.

■ Problem: Login dialog is not recognized by Chrome (29+) browser during Web 
Functional test script playback. 

Resolution: Modify the script's navigation code to use the following URL format 
for the login navigation for Chrome browser playback (this format is supported by 
all browsers):
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String URL = "https://Username:password@WebURL"; 

where webURL is the original URL needed for the login navigation.

■ Problem: Forms applet actions are not recorded on Firefox with dynamic enabling 
of forms automation. 

Resolution: Always use static enabling of forms automation.

■ Problem: Certain Document Object Model events may not be recorded correctly 
when recording actions in JD Edwards EnterpriseOne Grid Controls. Be sure to 
verify the script recording in the following situations:

- Clicking a text link in a JDE Grid cell.

- Clicking an image link in a JDE Grid cell.

- Clicking a checkbox in a JDE Grid cell.

- Clicking a tree node in a JDE Grid cell to expand/collapse tree in JDE Grid.

Resolution: In cases where the JDE Grid cell actions are not recorded properly, 
you can add the actions to the script tree using the Add...Other option on the 
Script menu. Expand the EnterpriseOne Actions and EOneGrid nodes, select the 
appropriate actions and specify the details. Alternatively, you can edit the script 
Java code in the Code View to add the actions in the appropriate locations using 
the JD Edwards EnterpriseOne Grid Control API, as follows:

eone.grid(String path).clickCellLink(int row, int column)

eone.grid(String path).clickCellIcon(int row, int column)

one.grid(String path).setCellCheckBox(int row, int column, boolean checked)

one.grid(String path).expandTreeNode(int row) or eone.grid(String 
path).collapseTreeNode(int row)

The path parameter is the path of the JDE Grid control, which can be copied from 
another recorded statement. The row and column parameters are both the 0-based 
row/column indexes in the JDE Grid control.

■ Problem: Windows 7 does not permit running OpenScript as non-administrator 
user. Steps are not recorded in the Windows 7 Secure Desktop environment for 
non-administrator user when navigating between zones with different security 
settings. A new process for zones with different security level starts in the browser. 

For example, when starting recording, a browser (brower.launch) starts with the 
about:blank page – Internet Security Zone. If you start recording the 
application-under-test – Intranet security zone, a new browser process starts. The 
OpenScript toolbar is not enabled in the new process and steps performed in the 
application-under-test are not recorded.

Resolution: The following workarounds can be used:

- Set security settings for the Intranet zone to the same as the Internet zone.

- Add about:blank to the Local Intranet zone.

To set security settings for the Intranet zone:

1. In Internet Explorer, select Internet Options from the Tools menu.

2. Select the Security tab.
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3. Select Internet.

4. Note the security level settings for the Internet zone.

5. Select Local intranet.

6. Set the Security level setting to the same setting as the Internet zone.

7. Click OK.

To add about:blank to Local Intranet zone:

1. In Internet Explorer, select Internet Options from the Tools menu.

2. Select the Security tab.

3. Select Local intranet.

4. Click Sites.

5. Click Advanced.

6. Type about:blank into Add this website to the zone field.

7. Click Add.

8. Click Close.

9. Click OK.

10. Click OK.

11. Use the Intranet zone when recording or playing back scripts in OpenScript.

■ Problem: Adobe Flex controls do not record during Adobe Flex functional testing.

Resolution: The Flex application must include the Adobe Flex automation 
libraries either at compile time or at run time. You need at least automation.swc 
and automation_agent.swc from the Adobe <flex 
builder>\sdks\3.5.0\frameworks\libs folder (3.5.0 is an Adobe sdk version). 
Also, automation_dmv.swc is required for charts, advanceddatagrid and 
olapdatagrid support. See the Creating Applications for Testing section of the 
Adobe Flex Data Visualization Developer's Guide for additional information about 
the tasks required to include the Flex automation libraries.

Creating Applications for Testing:

http://livedocs.adobe.com/flex/3/html/help.html?content=functest_
components2_15.html#178953

Adobe Flex Data Visualization Developer's Guide:

http://livedocs.adobe.com/flex/3/html/help.html?content=functest_
components2_15.html#178953

The Oracle OpenScript openscript_agent.swc file must be included when 
re-compiling Flex applications. The Flex application must be linked with the 
OpenScript Flex agent located in 
<installdir>\OpenScript\plugins\oracle.oats.scripting.modules.flexFT_
version\flexagent\openscript_agent.swc or equivalent.

Note: The automation libraries/swc files are required for Flex 
Functional Testing only. This does not apply for Adobe Flex (AMF) 
load testing which records at the protocol level.
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■ Problem: Automatic proxy configuration (Preferences - OpenScript - Record - 
HTTP Module) for Firefox may not correctly configure the browser proxy. 

Resolution: To record through Firefox, you should configure the browser proxy 
settings manually (Default: host=localhost, port=7777).

■ Problem: Certain systems may have trouble launching the OpenScript Help (Help 
- Help Contents). 

Resolution: This can be resolved by configuring the help to open in an external 
browser window:

1. From the Tester Perspective, select View - OpenScript Preferences. 

2. Click the "Clear" icon next to the filter text field in the upper left. Click the 
Help tree node and check the "Use external browser" box in the Help 
preferences. 

3. Click OK and relaunch OpenScript Help.

■ Problem: When recording a functional testing script you get the following error: 
“Cannot connect to browser”.

Resolution: The browser did not come up in the required amount of time when 
you clicked the Record button. This could be because the machine was busy or the 
ATS OpenScript browser add-ons for IE or Firefox were not installed properly. You 
can try increasing the browser “Startup timeout” setting under OpenScript 
Preferences, General…Browser section. If that does not work, run the OpenScript 
Diagnosis Tool under OpenScript Help. The Diagnosis Tool will attempt to correct 
any browser add-on installation problems, and report any failures it encounters.

■ Problem: When recording a functional testing script, you do not see any actions 
added to the script after recording.

Resolution: The browser add-on is not capturing events and sending them to 
OpenScript during recording. Run the OpenScript Diagnosis Tool under 
OpenScript Help. The Diagnosis Tool will attempt to correct any browser add-on 
installation problems, and report any failures it encounters. You can also try 
switching from IE to Firefox to see if that works better.

■ Problem: When you record a Web load test script, you do not see any navigations 
added to the script after recording.

Resolution: OpenScript uses an HTTP proxy server between OpenScript and the 
target application when you record Web load test scripts. If your browser is 
accessing the Web via a proxy, you may need to chain that proxy through 
OpenScript’s HTTP recording preferences. OpenScript will attempt to chain the 
proxy automatically for you using the browser’s proxy settings. If you do still 
have problems recording HTTP navigations, check the “HTTP” Record preferences 
for network interface and proxy settings.

Also, if you are recording a load test script against a local Web application running 
on the same machine as OpenScript (like Weblogic Medical Records), you cannot 
use "localhost" as the server name in the http request. So in the browser, specify 
your starting URL as: http://systemname:7011/medrec/index.action instead of 
http://localhost:7011/medrec/index.action.   This has to do with the fact that IE 
bypasses the proxy for localhost addresses and is not an issue for recording in 
Firefox. 
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■ Problem: When recording an Oracle EBS/Forms functional testing or load testing 
script, the browser appears to hang when loading the Oracle Forms applications 
and you are not able to continue.

Resolution: The browser you are using to record your script may not have the 
proper JVM version downloaded/installed that is required to run the Oracle 
Forms applications. Before you start recording Oracle EBS/Forms functional 
testing or load testing scripts, step through the EBS/Forms transaction once in the 
browser stand-alone (i.e. while not recording) to make sure you have the proper 
JVM downloaded/installed and confirm that the Forms applications run properly 
– then try to re-record your script.

■ Problem: When recording a Siebel functional testing or load testing script, the 
browser appears to hang when loading the Siebel High Interactivity applications 
and you are not able to continue.

Resolution: The browser you are using to record your script may not have the 
Siebel High Interactivity Framework Active-X components installed that are 
required to run the Siebel HI applications. Before you start recording Siebel 
functional testing or load testing scripts, step through the Siebel transaction once 
in the browser stand-alone (i.e. while not recording) to make sure you have the 
proper components downloaded/installed and confirm that the Siebel HI 
applications run properly – then try to re-record your script.

■ Problem: When recording a Siebel functional testing script, you do not see any 
Siebel High Interactivity component actions recorded in your script.

Resolution: In order to record Siebel functional testing scripts in OpenScript, the 
Siebel Test Automation Component Automation Services (CAS) must be enabled 
on Siebel Server before recording. Please review the documentation for 
information on how to enable Siebel Test Automation for Siebel 7.7, 7.8 and 8.x 
versions. This is not required for Siebel load testing scripts.

■ Problem: A database error occurs when trying to generate graphs in Oracle Load 
Testing.

Resolution: This may occur if the Oracle XE database was installed separately and 
not part of the Oracle Application Testing Suite installation. The default setting for 
allowed connections for the XE process is low and needs to be increased. From a 
command prompt, run the following command, then restart Oracle XE:

alter system set processes=200 scope=spfile;

Web Functional Test Recording with Firefox Troubleshooting
The following section describes Web Functional Test Recording with Firefox 
Troubleshooting techniques.

■ When using the Firefox browser, you should disable or not install any add-ons into 
the OpenScript-created Firefox profiles.

Command-Line Script Execution
The following are tips, known issues, and workaround solutions for running 
OpenScript scripts from the Command-Line Interface (CLI). 

■ Problem: Playback does not recognize objects outside of the visible window area. 
(Note: this is also applicable to playback of scripts from the OpenScript UI.)
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Resolution: When playing back scripts, make sure the browser window is the 
same size as when the script was recorded. One way to ensure that the browser is 
the same size is to record the script with the browser window maximized, then 
add a web.window("path").maximize() method to the script code before playing 
back the script. Also, make sure the machine used to play back the script is set to 
the same screen resolution as the machine used to record the script.

■ Problem: Playback does not recognize recorded keyboard actions.

Resolution: When recording scripts for command-line execution, use mouse clicks 
instead of keyboard actions to interact with the application-under-test. For 
example, when filling in forms, click the mouse on the form fields before entering 
text rather than using the Tab key. Also, click the Submit button with the mouse 
rather than pressing the Enter key.

■ Problem: Playback does not work with Remote Desktop minimized.

Resolution: Make sure the Remote Desktop is visible/maximized before playback. 
Alternatively, you can add the RemoteDesktop_SuppressWhenMinimized value to 
the Registry of the system from which you are running the command-line 
interface, as follows:

1. Close any currently open Remote Desktop connections. 

2. Select Run from the Start menu.

3. Type regedit and click OK.

4. Expand one of the following Registry keys depending upon the system and 
which user account you want to use for the command-line execution:

– for 32-bit current user account:

HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client

– for 32-bit all user accounts:

HKEY_LOCAL_MACHINE\Software\Microsoft\Terminal Server Client

– for 64-bit current user account:

HKEY_CURRENT_USER\Software\Wow6432Node\Microsoft\Terminal Server Client

– for 64-bit all user accounts:

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\Terminal Server 
Client

5. Select New from the Edit menu, then select DWORD (32-Bit) Value.

6. Enter RemoteDesktop_SuppressWhenMinimized as the name and press Enter.

7. Double-click the RemoteDesktop_SuppressWhenMinimized registry entry to 
open the edit dialog box.

8. Specify 2 in the Value Data field and click OK. 

Caution: The following procedures modify your system Registry. 
Modifying the system Registry carries risk of causing serious 
problems that may affect the operation of your operating system 
software. Use the information provided at your own risk.
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9. Close the Registry Editor.

■ Problem: Need to automatically initiate a Remote Desktop connection after a 
reboot.

Resolution: You can initiate a Remote Desktop connection after rebooting the test 
machine using a saved Remote Desktop Protocol (.rdp) file for a Remote Desktop 
connection.

To specify and save a Remote Desktop Protocol file:

1. Select Accessories from the Start menu, then select Remote Desktop 
Connection.

2. Click the Options button.

3. Specify the Logon settings in the General tab.

4. If you wish to be able to start the Remote Desktop Connection without being 
prompted for credentials (user and password), select Allow me to save 
credentials.

5. If you wish to automatically start a program on the Remote Desktop 
connection, click the Programs tab and specify the program to start.

6. Click the Connect button.

7. Enter the username and password and click OK.

8. Close the Remote Desktop connection.

9. Select Accessories from the Start menu, then select Remote Desktop 
Connection.

10. Click the Options button.

11. Select the General tab, if necessary, and click Save As.

12. Specify the directory and file name for the .rdp file and click Save.

13. If you wish to automatically scale the Remote Desktop when connecting, edit 
the saved .rdp file in a text editor and add the following setting to the end of 
the settings:

smart sizing:i:1

14. Schedule the .rdp file to launch automatically after a reboot/restart using Task 
Scheduler or create a batch file on the test machine using a text editor with the 
following command:

mstsc c:/myRdpFile.rdp

where myRdpFile is the name you used to save the Remote Desktop 
connection file.

15. If you use a batch file, schedule the batch file to run using a tool that is capable 
of launching the batch file automatically after a reboot/restart.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.
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Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.
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